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National NHS Staff Survey 2005 Guidance Notes 
 
 
Introduction 
 
The main purpose of these Guidance Notes is to guide trusts, PCTs and Survey 
Contractors through the practical steps of conducting the National Staff Survey.  The 
guidance notes are separated into two main sections. 
 
Part One - Introduction to the National Survey 

 
1.1. Background to the survey 
1.2. Summary of minimum survey requirements for trusts 
1.3. Summary of minimum survey requirements for Strategic Health Authorities 
1.4. Timetable for the survey 
1.5. Changes since the 2004 survey 
1.6. Health and Safety Executive Stress Audit 
1.7. Merging PCTs 
1.8. Immediate preparation for the 2005 survey 

 
Part Two: Step by step instructions for the National Staff Survey  
 

2.1. Key survey contact within the trust 
2.2. Approved Contractors 
2.3. The questionnaire 
2.4. Breakdown of results by directorate / department / site 
2.5. Preparation of staff lists 
2.6. Selecting the Staff Sample 
2.7. Pre-survey communication with staff 
2.8. Boosting response rates 
2.9. Printing of questionnaires, covering letters and reminder cards/letters 
2.10. Distribution and receipt of questionnaires, and prompting non-respondents 
2.11. Data entry and data transfer to the Advice Centre 
2.12. Reports of the survey findings 
2.13. Ethical considerations  

  
The appendices contain templates of the letter to accompany the questionnaire, the 
reminder letters, as well as details of information and documents to be transferred to 
the Advice Centre. They also include a list of changes to the Core questionnaire from 
2004, details of questions that can be used for the Health and Safety Executive 
Stress Audit and Improving Working Lives, and some instructions for carrying out 
basic operations in Excel (necessary for the sampling stage). 
 
 
An Advice Centre web site and advice line is available for the National Staff Survey. 
 
• Web site: www.nhsstaffsurveys.com 
• Advice Line: 0121 359 2491 (9.30am – 4.30pm, Monday to Friday). 
• E-mail: enquiries@nhsstaffsurveys.com 
 
Researchers from the Advice Centre will provide practical support and advice to the 
trusts as they conduct the survey. 
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PART ONE: INTRODUCTION TO THE NATIONAL SURVEY 
 
 
1.1. Background to the survey 
In 2003, the Commission for Health Improvement (CHI), in conjunction with the 
Department of Health, appointed Aston University to develop and pilot a new national 
NHS staff survey, and to establish an Advice Centre and web site to support that 
process. The three organisations worked in partnership to consult widely with NHS 
staff about the content of the survey, under the guidance of a stakeholder group, 
which had representatives from Staff Side, CHI, DH, HR Directors, Strategic Health 
Authorities and the NHS workforce. 
 
The purpose of this survey was to collect staff views about working in their local NHS 
trust.  The intention was that it would replace the need for trusts to carry out 
numerous staff surveys – it was designed to replace trusts' own annual staff surveys, 
the Department of Health 10 core questions, and the CHI Clinical Governance 
Review staff surveys.  It was intended that this survey would be implemented 
annually, and cover the needs of CHI, DH and trusts.  Thus, it would provide 
information both for deriving national performance measures (including star ratings) 
and for helping the NHS, at both a national and local level, work towards Improving 
Working Lives.   
 
After a pilot study in five trusts, the survey was implemented in full in the autumn of 
2003. Every NHS trust in England took part, with nearly 370,000 staff sent 
questionnaires. 56% of these responded, and the data was analysed by the Advice 
Centre at Aston University. The survey was repeated in 2004, with an even higher 
response rate – 60% of all staff sent questionnaires returned a completed 
questionnaire. 
 
Each year, all trusts receive a feedback report that compares their scores with those 
of all trusts of a similar type nationally. In addition to this, reports on key survey 
findings are published each year. All these reports, together with spreadsheets of 
detailed responses to the 2003 and 2004 surveys from each trust and summaries of 
groups of trusts, are available online at  
http://www.healthcarecommission.org.uk/staffsurveys/. 
 
CHI has now been replaced by the Healthcare Commission, which took over 
responsibility for the survey in 2004. The survey will continue to be operated as an 
annual survey. 
 
 
1.2. Summary of minimum survey requirements for trusts 
It will again be obligatory for all NHS trusts in England to implement the survey with a 
sample of their staff in the Autumn of 2005.   
 
All trusts must follow a standard methodology, as described in detail later in these 
guidance notes, and must fulfil the following minimum requirements: 
 
• A self-completion questionnaire with a random sample of staff 

(see section 2.6 for more details on sampling) 
 
• The questionnaire must contain the full set of Core questions 

(see section 2.3 for more details on the questionnaire) 
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• A staff survey communication strategy must be implemented 
(see section 2.7 for more details on internal communication) 

 
• Questionnaires (each labelled with a unique staff ID number) to be distributed to 

selected staff, with at least two reminders being sent to non-responding staff (2nd 
reminder to be accompanied by a 2nd copy of the questionnaire) 
(see section 2.10 for questionnaire distribution procedures) 

 
• An external organisation must be appointed to act as a survey contractor. As a 

minimum, this organisation should be responsible for receipt of completed 
questionnaires, data entry and editing, and provision of this data to the Advice 
Centre. It is strongly recommended that trusts use one of the Approved Survey 
Contractors 
(see section 2.2 for details of the Approved Contractors) 

 
There are a number of additional ways in which trusts can adapt the survey to their 
local needs: 
 
• trusts may conduct a survey with a larger staff sample or census 
• trusts may select additional questions from an Optional Question Bank 
• trusts may include a limited number of their own Local questions on other topical 

issues 
 
More detail about all these survey elements can be found later in sections 2.3, 2.4, 
2.5 and 2.6.  
 
 
1.3 Summary of minimum requirements for Strategic Health Authorities 
 
Strategic Health Authorities, Workforce Development Confederations and other NHS 
employers are also encouraged to conduct the survey, although it is not compulsory 
that they do so. 
 
A separate version of the questionnaire has been produced this year for Strategic 
Health Authorities.  It is almost identical to the trust version, although references to 
“your trust” have been replaced with references to “your Strategic Health Authority” or 
“your SHA”. 
 
If SHAs participate in the survey, and require an Advice Centre feedback report, then 
all the minimum requirements set out above in section 1.2 apply.  If minimum 
requirements are not fulfilled, it might not be possible for the Advice Centre to include 
the SHA data in its benchmarked national data set.  The one possible exception to 
this is the use of an external survey contractor, as we appreciate that the cost of 
employing a survey contractor this year for very small SHAs might be prohibitive.  
However, we would still strongly recommend the use of an Approved Contractor, as 
the use of an external contractor is the only way to truly guarantee to staff that no 
one from the trust will see their completed questionnaires. 
 
N.B. All section 1.2 minimum requirements, including use of an external survey 
contractor, are compulsory for trusts. 
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1.4. Timetable for the survey 
Questionnaires should be distributed no later than the week commencing 3rd October 
2005, but may be sent out up to a month before this if that is more convenient for 
trusts (e.g. to attach the questionnaires to payslips).  
 
Three weeks after the initial mailing (w/c 24th October if the initial mailing was w/c 3rd 
October), trusts should distribute a first reminder letter to all staff who have not yet 
returned a questionnaire. 
 
A second reminder letter, together with an extra copy of the questionnaire, should be 
distributed to non-responding staff a further three weeks later (w/c 14th November, if 
the initial mailing was in w/c 3rd October).  
 
Survey data should be transferred to the Advice Centre during the week commencing 
12th December 2005. 
 
The Advice Centre will produce reports of national results and trust level results in 
late February / early March 2006. Trusts are, however, able to commission reports 
based on their own data from their contractors, which can be developed prior to the 
standard reports they receive from the Advice Centre. 
 
A detailed timetable for the survey can be found at the beginning of PART 2 (page 
8). 
 
 
1.5. Changes since the 2004 survey 
There have been relatively few changes to the survey procedures since the 2004 
survey. The main changes that affect trusts and contractors are listed below: 
 
• Contractors should now record the date of questionnaire receipt on the Excel data 

sheets to be returned to the Advice Centre (see section 2.9) 
 
• Optional question data should also be recorded on an Excel data sheet to be 

returned to the Advice Centre (see section 2.11).  For the first time this year, the 
Advice Centre will be providing Trusts with benchmarks from the Bank question 
results from the Basic Sample of staff   

 
• Trusts now have the option of TWO within-trust breakdowns (e.g., directorate and 

location) to be included within the Advice Centre feedback reports (see section 
2.4) 

 
• It is recommended that trust logos are included in covering letters. This helps staff 

to know that the survey is supported by the trust, and allows any staff working in 
more than one trust to identify easily which trust they should be responding about 

 
• We are no longer requiring ethnic group information for individual respondents. 

Rather, we will be requesting a summary of the ethnic group profile in each trust at 
a later stage (see section 2.4) 

 
• Contractors should inform the Advice Centre of the number and nature of queries 

to their advice line on a weekly basis during the survey period (see section 2.10) 
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• The occupational group question in the survey has been expanded this year, and 
we have introduced some editing rules for contractors, to be followed when 
individuals give more than one response (see section 2.11) 

 
• The honorary contract for use when questionnaires are to be sent to home 

addresses has been expanded. This is now downloadable from the Advice Centre 
web site (www.nhsstaffsurveys.com) (see section 2.5) 

 
• Due to some respondents’ confusion in previous years over the meaning of the 

word “organisation”, this has been replaced in this year’s questionnaire by the 
word “trust”. This means that SHAs will have a slightly different version of the 
questionnaire, which may have an impact on the cost of conducting surveys in 
SHAs. 

 
 
1.6 Health and Safety Executive Stress Audit 
 
As in 2004, the questionnaire includes questions which can be used for the purposes 
of the Health and Safety Executive’s (HSE) stress audit, and the HSE has agreed 
that trusts will not need to carry out a separate survey to cover this. Details of the 
questions which map onto the HSE standards can be found in Appendix 8.  
 
 
1.7. Merging PCTs 
 
Over the coming months, many PCTs will be merging to form larger organisations. 
This clearly has major implications for the survey in these PCTs, as mergers will 
often be happening during the survey period.  There are two ways in which PCTs that 
are merging can proceed: 
 
1. Merging PCTs could combine the staff lists of the merging organisations, and 

draw a joint sample from this joint staff list. 
 

A single, combined feedback report would then be produced by the Advice 
Centre in February 2006. This single staff survey approach across merging PCTs 
might be the preferable option if the merger were well under way by the time the 
survey period starts 

 
2. Merging PCTs could continue to run separate surveys at each PCT. This might 

be the preferable option if the merger were not due to take place until 2006 
 
If the second option is taken and separate PCT surveys are conducted, the merging 
PCTs would then have two choices: they could either opt to receive separate 
feedback reports for each PCT from the Advice Centre in February 2006, or could 
ask for a single report, which combines the results from each merging PCT. 
 
The decision about which of these options to use is up to each set of merging 
PCTs. However, the decision made should be communicated to the Advice Centre 
along with the sampling information – no later than October 14th (see section 2.6). 
 
It is also strongly advised that sets of merging PCTs use the same survey 
contractor. 
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1.8. Immediate preparation for the October survey 
There are a number of key tasks that should be started as soon as possible, to help 
ensure that organisations are ready to conduct the survey: 
 
• updating of the trust staff database, including accuracy of work address 

information (or home address information if applicable – see section 2.4), in 
preparation for selecting the staff sample (see sections 2.4, 2.5) 

• making contact with the Advice Centre, to let them know which members of staff 
will be responsible for the survey implementation (please see section 2.1) 

• making contact with an Approved Survey Contractor, who will be able to help the 
trust with the preparation for and implementation of the survey (see section 2.2) 

 
 
Please see page 3 for contact details of the Advice Centre. 
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PART TWO: STEP BY STEP INSTRUCTIONS 
 
The following step-by-step instructions are designed to guide trusts, PCTs and 
Survey Contractors through the survey procedures. 
 
An Advice Centre, based at Aston University, has been set up to support the whole 
process.  You will have access to the Advice Centre throughout the National Staff 
Survey period.  See page 3 of these Notes for information on how to contact the 
Advice Centre. 
 
The timetable of steps necessary for survey implementation is given in the following 
table: 
 
Date Step of Survey Implementation By whom? Section in 

Guidance 
Notes 

By mid-August  Identify two individuals within the trust who 
will take responsibility for the survey and 
inform the Advice Centre of the contact 
details of these people 

Trust 2.1 

w/c August 
29th 

Ensure staff lists are comprehensive and up 
to date 

Trust 2.5 

By end August 
/ early 
September 

Appoint a survey contractor to help with the 
survey implementation 

Trust 2.2 

By w/c 
September 
12th 

Agree the precise division of labour between 
trust and contractor (e.g. who is responsible 
for sampling, printing, packing  survey 
materials ready for distribution, taking receipt 
of completed questionnaires, monitoring 
response rates etc) 

Trust and 
contractor 

2.2 

By w/c 
September 
12th 

Decide on the precise content of the 
questionnaire, and communicate this to 
contractor (all trusts must include the Core 
questions) 

Trust 2.3 

By w/c 
September 
12th 

Decide on what within-trust breakdown (e.g. 
directorate, department or location) should be 
used, and ensure that this information is 
included in the staff list 

Trust 2.4 

By w/c 
September 
19th 

Communicate with trust staff.  Arrange some 
internal publicity within the trust about the 
forthcoming survey. Include intention to 
distribute questionnaires to home addresses 
if applicable. 

Trust 2.7 

By w/c 
September 
26th 

Arrange printing of the various survey 
documents - questionnaires, letters, reply-
paid envelopes (each questionnaire to be 
printed or labelled with a unique staff 
identification number to help with monitoring 

Trust or 
contractor 

2.9 
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response rates and targeting reminders) 

By w/c 
September 
26th 

Inform the post room(s) of the forthcoming 
questionnaire distribution and reminders, 
ensuring that they are aware of the 
importance of the survey and the likely 
volume of post 

Trust 2.7 

By w/c 
September 
26th 

Set up honorary contracts with contractor if 
home addresses are to be used for 
questionnaire distribution 

Trust and 
contractor 

2.5 

w/c October 
3rd1 

Arrange distribution of questionnaires to the 
selected sample via the internal post or home 
addresses 

Trust or 
contractor 

2.10 

Weekly during 
survey period 

Monitor response rates to this first mailing, 
and make use of the unique ID numbers on 
returned questionnaires to record which 
members of staff have not yet responded  

Contractor 2.10 

Weekly during 
survey period 

Inform Advice Centre of ongoing response 
rates, and the number and nature of helpline 
queries received 

Contractor 2.10 

w/c October 
10th 

Inform Advice Centre of the total number of 
staff eligible to receive the survey, and the 
size of the Basic Sample selected. Merging 
PCTs should also inform the Advice Centre 
of decisions about whether they are 
proceeding with the survey jointly or 
separately 

Contractor 2.6 / 1.7 

w/c October 
24th2 

Three weeks after the initial mailing, arrange 
distribution of a reminder letter to all staff who 
have not yet returned a questionnaire 

Contractor 
and trust 

2.9 

w/c November 
14th3 

Three weeks after the first reminder letter, 
arrange distribution of a 2nd copy of the 
questionnaire to all non-responding staff, 
together with a reminder letter and another 
reply-paid envelope 

Contractor 
and trust 

2.10 

w/c December 
12th 

Arrange for data from the completed 
questionnaires to be keyed or scanned, and 
to be transferred to the Advice Centre in the 
prescribed format 

Contractor 2.11 

 
 
2.1. Key survey contacts within trust 
 
At the start of the process, it is important to identify two people within the trust who 
will take responsibility for the survey and communication with the Advice Centre and 
survey contractor. Although it is likely that only one of these will actually have 

                                                 
1,2,3 Or earlier date: see section 2.9 



 11

responsibility for the survey, the previous surveys have showed that contact between 
the Advice Centre and trusts was far smoother where there were two named contact 
people, as there were fewer delays due to sickness or absence etc. 
 
If your trust has not already informed the Advice Centre of the names and contact 
details of these individuals, it should do so at the earliest opportunity. 
 
 
2.2. Approved Survey Contractors 
 
We are strongly recommending that trusts appoint one of the seven Approved Survey 
Contractors to support them.  These contractors have been fully vetted by the 
Healthcare Commission, and have proved that they are able to provide a high quality 
service whilst offering value for money.  They all took part in the 2003/2004 surveys 
with great success. 
 
As a result, it is not necessary for trusts to conduct their own lengthy and costly 
individual tender exercises.  
 
All seven Approved Contractors have been briefed in detail by the Advice Centre, 
and will be in close liaison with Advice Centre staff throughout the survey period.  
Furthermore, all Approved Contractors have contracts with the Healthcare 
Commission, under which they guarantee the provision of a high quality service. 
 
The seven Approved Contractors are:- 
 
• Maritz 
• MORI 
• NHS Partners’ Research & Information 
• Picker Institute Europe 
• Quality Health 
• RBA Research 
• Taylor Nelson Sofres 
 
Contact details for these seven organisations can be found in Appendix 7.  More 
detailed information about them, including their quotations for providing the survey 
services can be found in the Service Level Agreement which is available on the 
Advice Centre web site. Although there are some differences between the 
contractors, in general they all offer similar services at similar prices. 
 
When using an Approved Contractor, trusts can select from a menu of services, 
including: 
  
• Providing advice and support to trusts in selecting the staff sample 
• Printing questionnaires, covering letters and reminders 
• Packing up survey materials, ready for internal distribution by the trust  
• Handling receipt of completed questionnaires, and liaising with trusts about non–

responses and the distribution of reminders* 
• Providing support to ensure good response rates 
• Data entry and transferring the cleaned data to the Advice Centre* 
• Analysis and reporting of findings (n.b. the Advice Centre will be providing each 

trust with a basic set of tables with the core question findings in late February / 
early March 2006) 
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(* it is mandatory that these elements are handled by an external contractor for 
confidentiality reasons) 
 
The precise work to be carried out by the approved contractors will vary from trust to 
trust.  While some trusts may choose to appoint a contractor to conduct the whole 
survey, others may wish to do some of the work themselves in order to keep costs 
down.   
 
When deciding on what parts of the process to use the contractor for, it is worth 
remembering that the use of an approved contractor can help to limit the burden on 
trust staff time.  The amount of staff time needed to co-ordinate a large-scale survey 
is often under-estimated.  In particular, organising the printing and packing of survey 
materials, can be very time-consuming tasks, and can take trust staff away from their 
usual work. 
 
Although we strongly recommend using an Approved Contractor, it is recognised that 
some trusts may choose to use a non-approved contractor.  If this is the case, it is 
essential that the instructions contained in the following pages are followed diligently 
by the contractor.  This is necessary to ensure all trusts are producing results that are 
comparable. It is also important that any non-approved contractors make contact with 
the Advice Centre, so that they can be contacted directly in case of any queries, and 
that data may be passed between the contractor and Advice Centre without 
compromising respondent confidentiality. 
 
 
2.3. The Questionnaire 
 
The next important step is to decide on the precise content of the questionnaire to be 
used in your staff survey.  The questionnaire has three potential components, only 
one of which is compulsory: 
 
• A set of Core (compulsory) questions, which must be asked in all trusts 
• A set of Bank (optional) questions  
• Local questions 
 
All trusts must include the full set of Core questions in their questionnaire, but also 
have the option of selecting additional questions from an Optional Question Bank.  
These can be put together using a Compilation Tool available on the Advice Centre 
web site (see section 2.3.4). It is hoped that the Core and Bank questions will cover 
all the key staff issues for the majority of trusts.  However, trusts also have the option 
of including additional Local questions, to cover issues of particular local interest. 
 
 
2.3.1. Core Questions 
The Core questions cover: 
 
• Work-life balance 
• Appraisals & Personal Development Plans 
• Training, Learning and Development 
• Team Working 
• Errors and Incidents 
• Questions about respondents’ jobs (including involvement in decision making, 

work pressure, job satisfaction and intention to leave) 
• Management and Supervision 
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• Organisational Climate 
• Equal opportunities 
• Whistle-blowing 
• Harassment and Bullying 
• Infection Control and Hygiene 
• Background Details. 
 
There have been a number of changes to the Core questionnaire, including the 
addition of two questions on training, learning and development, and two on infection 
control and hygiene. A small number of questions have been dropped from the Core 
questionnaire, but have been retained as Bank questions.  These changes are all 
listed in Appendix 10. 
 
 
2.3.2. Inclusion of Bank questions 
The optional Bank questions cover: 
 
• Type of shift working 
• Length of time to travel to work 
• Further issues on Training, Learning and Development (protected time, benefits 

received from training, climate for training, training on giving advice re: alcohol, 
drugs) 

• Access to counselling services and occupational health services 
• Agenda for Change 
• Cleanliness, comfort and safety of the work environment 
• Smoking policy 
• Provision of healthy living options and advice for staff 
• Access to IT 
• Methods of communication from trust 
• Pay and conditions 
• Types of patient worked with 
• Directorate, division, department or location in which the employee works** 
 
These questions have been designed by the Advice Centre, the Healthcare 
Commission and Maritz Research, and, like the Core questions, have all been piloted 
successfully in NHS trusts.   Documents containing the Core questions only, and the 
Bank questions only, are separately available on the Advice Centre website. 
 
** Although a question has been included in the Optional Bank to collect information 
about the directorate, division, department or location of each staff member, a much 
better way of ensuring accurate analysis of results by directorate, department etc is 
for the trust to include it in the original staff list used at the sampling stage (please 
see section 2.4 for detailed instructions about how to do this). This is a much more 
reliable way of ensuring the information is available and correct for each staff 
member (e.g. in past trust surveys, staff have not always been sure in which 
directorate they work).  The Advice Centre will use directorate / department 
information on the staff list to present up to two directorate level breakdowns of trust 
results in the standard feedback report in February 2006.  We would therefore 
strongly recommend that this method is chosen, rather than using the Optional Bank 
question.  However, the bank question can be used as a fallback option, if it proves 
too difficult for the trust to include the information on the staff list.   
 
Please note that the precise wording of the Bank question about directorate / division 
/ department will need to be amended to suit the local trust structure.  The 
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Compilation Tool enables you to insert the desired question and answer categories.  
There is space for up to 12 different categories. 
 
If this optional directorate / department question is used, it may still be possible for 
Advice Centre reports to include results by this breakdown. Please ensure that 
contractors include all relevant information (breakdown used and codes used) when 
communicating this information to the Advice Centre. 
 
 
2.3.3. Inclusion of Local questions 
If there are additional staff issues which are very important locally, then it is up to 
trusts, and their appointed survey contractors, to design any additional Local 
questions.  As far as possible, these local questions should be of a similar style to 
that of the Core and Bank questions, to retain consistency within the questionnaire.  
These should be designed on separate pages, but then added to the pages of the 
PDF generated by the compilation tool, so that all questions can be printed within a 
single booklet. Decisions about the inclusion of specific local questions should be 
made, and communicated to survey contractors, by the week beginning 12th 
September. 
 
Please note however, that according to the terms of the Ethical Approval granted by 
MREC North West Board for the National Staff Survey, trusts are required to submit 
any additional Local questions for approval by their Trust Management Board.  (All 
Core and Optional Bank Questions are already fully ethically approved for use 
nationally, and do not need to be submitted for further approval in this way.  For 
further details about ethical approval, see section 2.13).  
 
2.3.4 Creating the questionnaire for your trust 
Once it has been decided which questionnaire elements are required for use in the 
trust, the questionnaire can be generated using the Questionnaire Compilation Tool 
on the Advice Centre website (www.nhsstaffsurveys.com). The Compilation Tool 
inserts Bank (optional) questions into the appropriate place on the questionnaire. A 
username and password (chosen by individual users) need to be entered, to enable 
identification of each questionnaire, allowing it to be saved and retrieved. 
 
Trusts will have already been sent a PDF file of the 12-side Core questionnaire, with 
an electronic copy of these guidance notes. This should be used for reference only, 
and not for printing and sending out. If your trust has not yet received these 
documents, please contact the Advice Centre as soon as possible.   The Compilation 
Tool on the Advice Centre web site (described below) should be used for creating the 
questionnaire to be sent out – this will allow the insertion of the name, and return 
address, of an external survey contractor (essential to guarantee confidential 
treatment of staff responses).  
 
The Compilation Tool can be used to: 
• specify the address to which completed questionnaires must be sent (i.e. the 

postal address of the survey contractor) 
• specify a telephone helpline number that the contractor may have set up to 

answer staff queries 
• select optional Bank questions for inclusion in the questionnaire 
• alter the type of organisation mentioned in the questionnaire from “trust” to “SHA” 

for use by Strategic Health Authorities. 
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Once all the required elements have been selected, the questionnaire can be 
generated by the click of a button, “Generate PDF”. This produces the questionnaire 
in a PDF format, which can then be saved on the website, saved to disk, or printed. It 
is important to check the questionnaire contains the desired Bank questions, and that 
the instructions on the front cover (in particular return address and helpline number) 
have been generated correctly. 
 
 
2.3.5 Length of the questionnaire 
As mentioned earlier, the Core questionnaire is 12 A4 sides in length.  Clearly, the 
inclusion of additional non-Core questions will increase the length of the 
questionnaire.  
 
It is recommended that, if further Optional Bank or Local questions are added, the 
questionnaire should be limited to a maximum of 16 A4 sides.  A questionnaire that is 
longer than this will have an adverse effect on response rates. 
 
 
2.4 Breakdown of results by directorate / department / site 
 
The Advice Centre trust feedback report can, if trusts wish, include up to two 
breakdowns by directorate, department or location.  This will enable trusts to 
compare, for example, the responses of staff from different directorates.  In order to 
achieve this, sufficient information needs to be included on the staff lists supplied to 
contractors. 
 
Section 2.5 goes through each step involved in preparing a staff list for the survey.   
 
Before this staff list preparation begins, trusts need to decide on a suitable 
departmental or directorate breakdown (for use in analysis of the survey findings).   
 
1. Each breakdown should have mutually exclusive and comprehensive categories, 

i.e. each member of staff should be included in one, and only one, of the 
categories in each breakdown. 

 
2. These categories may be directorates, or departments, or locations, or any 

similar type of breakdown that is appropriate for the trust.  Examples of the types 
of breakdowns that trusts might wish to include are shown below: 

 
- An acute trust spread across a number of locations may wish to have a 

breakdown of staff responses by location 
- A mental health trust that has a particular interest in differences between 

occupational groups (other than those already provided in the questionnaire) 
may wish to have a breakdown by staff group 

- A PCT with teams of staff based in several locations may wish to have a 
breakdown by clinical base 

- A care trust may choose to have a breakdown by directorate; and may also 
want to compare the responses of staff who are seconded from the local 
authority, with the responses of other trust employees 

- Trusts that employ substantial numbers of shared service staff (i.e. staff 
offering services both to the employing trust and to other trusts in the area) 
may want to have such staff separately identified as a staff group for analysis 
in the report, so may choose this as a one of their breakdowns 
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3. If such breakdowns are required in the Advice Centre report, then careful thought 
needs to be given to the design of the categories, to ensure that a large enough 
number of staff are contained in each category.   
 
The Advice Centre report will focus on the Basic Sample of 850 or fewer staff 
(see section 2.6.1); and in order to maintain confidentiality for individual staff 
members, the Centre report will not provide feedback on any group from which 
there are 10 or fewer responses.  Therefore, the directorate or department 
categories should be designed in such a way that there will be a minimum of 20 
staff in the Basic Sample. For trusts with a Basic Sample of 850, this is 
approximately 2.5% of the sample, so categories should represent a minimum of 
2.5% of the staff list. For trusts with smaller Basic Samples, this should be 
adjusted accordingly. 
 
In general we would recommend a limit of 12 categories to a breakdown (e.g. 12 
directorates, 12 locations). If there are substantially more than this, we would 
recommend that the trust combine some of the smaller categories. 
 
We recommend that trusts talk directly to their survey contractors (or the Advice 
Centre) at an early stage about the precise design of their directorate / 
department breakdown(s).  This will help to ensure that trusts' later analysis and 
reporting requirements can be met. 
 
(Please note: there is a limit to the breakdown possible in the Advice Centre 
report, which will focus on the Basic Sample only, but if the trust is conducting the 
survey with a larger staff sample, then more detailed directorate analysis may be 
possible.  Again, trusts should talk directly to their survey contractors about this 
when they are preparing their staff lists for the survey). 
 

4. Once suitable directorate / department categories have been agreed, each 
member of trust staff will need to be assigned to an appropriate category. 

 
5. Some trusts may want their survey contractor to organise separate batches of 

questionnaires for different sites within the trust, to help with internal distribution.  
If so, then the site needs to be clearly identified on the staff list for each staff 
member.  (In some cases, site may be the same as directorate / department).  
Again, it is recommended that trusts talk directly to their survey contractors about 
how best to identify site on the staff lists. 

 
6. Information on the directorate / department breakdown required should be sent to 

the Advice Centre by the survey contractor before the data transfer deadline 
(no later than December 9th). The Advice Centre will supply each contractor with 
a template for this information. This will ensure the breakdown of results can be 
generated on the reports without delay. 

 
Now please see section 2.5 for more information about preparation of the staff lists 
for sampling.  
 
 
 
2.5. Preparation for Sampling 
 
2.5.1 Preparation of Staff Lists 
One of the first steps towards conducting the staff survey is to compile a list of all 
staff that are eligible for the survey.  This needs to be carried out by a member of 
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trust staff, who is familiar with both the structure of staff records, and the computer 
programme Microsoft Excel. Please note that preparation of this staff list is the 
responsibility of the trust, not of the contractor. 
 
This list should include: 
 

• all full time and part-time staff who are directly employed by the trust on 
September 1st 

• trust employees on all types of contract  
– permanent 
– fixed period 
– locum 
– temporary 
– seconded staff (e.g. social care staff seconded from the local authority), 

but only if they are on the trust payroll 
– hosted staff who have a substantive contract with the trust 

 
The list should exclude1: 
 

• staff who are on long-term sick leave or maternity leave on September 1st   
• all staff employed by sub-contracted organisations or outside contractors 
• bank staff (unless they also have substantive trust contracts) 
• seconded staff who are on the payroll of another organisation (e.g. social care 

staff who are on the payroll of the local authority) 
• student nurses 
• non-executive directors 

 
Care should be taken to ensure that: 

• no eligible staff members have been omitted from the list; (this could 
potentially happen if, for example, staff records are kept separately for 
different departments or sites within the trust) 

• the list does not contain duplicate names 
• all ineligible staff have been excluded from the list 
• records are up to date as of September 1st, including address information 

 
If HR provision is shared between multiple trusts, then it is important that staff lists 
are separated in such a way that a separate sample can be drawn for each trust, not 
one overall sample for the provision. The staff list for each trust should be consistent 
with the instructions above. 
 
The exception to this is for PCTs which are merging, who may decide to combine 
staff lists to draw a single sample (see section 1.7). If this is the case, then care 
should be taken to ensure that the lists are in exactly the same format before they 
are combined. 
 
The staff list should be in Excel spreadsheet format, with one employee per row.  The 
first row should be used for column headings (Name, Staff Group, Address etc.), and 
                                                 
1 If trusts want to use the questionnaire to survey some of these excluded groups, they may 
do so as long as they do not form part of the Basic Sample. To do this, it is recommended 
that trusts follow these Guidance Notes to draw the Basic Sample, and then add on other staff 
groups afterwards. That way, responses from staff groups that are supposed to be excluded 
from the National Staff Survey will not be fed back to the Advice Centre (this would 
compromise the comparability of survey results between trusts). Please note, however, that 
authorisation should be obtained to survey any employees of external organisations. 
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there should be no blank rows.  Each employee should appear only once on the 
spreadsheet.  For each employee, the spreadsheet should contain the following 
information: 
 

• Full name 
• Sufficient address details (for internal distribution where staff have a 

permanent work address, or home address if not – see below) 
• Directorate, department or division (or whatever breakdown or breakdowns 

are required for the report – see section 2.4) 
• Location (if the questionnaires are to be separated into batches for different 

post rooms – see section 2.10) 
• Job title * 
• Staff Group * 

 
If the address provided is a work address, it needs to be sufficiently detailed to 
enable a questionnaire to be sent to each individual via the internal mail.   
 
As in 2004, it is now permissible to send questionnaires to home addresses of staff 
who do not have a permanent work address. If this is to be done, home address 
information for these staff needs to be included in the list. For more information on 
sending to home addresses, please see section 2.5.2. 
 
In 2005, we are not requesting that ethnic background information is included on the 
staff lists. However, the Advice Centre will be requesting a summary of the ethnic 
profile of trust employees at a later date during the survey process 
 
The asterisked information above is not absolutely essential, but would be extremely 
valuable both in monitoring response rates. It could also be used by the survey 
contractor for analysis purposes, although it will not be included in the standard 
Advice Centre report. Information on job title may be used to help improve the 
occupational group question in subsequent years. 
 
For further details of how staff lists should be formatted within Excel, see steps (a) to 
(c) of the instructions in section 2.6.3. 
 
2.5.2 Use of home addresses – ethical considerations 
If questionnaires are being sent to home addresses of any staff members, there are 
three steps that will need to be taken by trusts to comply with the ethical approval 
decision granted. 
 
1. To ensure there is no invasion of privacy, trusts should communicate to their 

workforce that ethical approval has been granted to deliver questionnaires to the 
home addresses of some of their staff on the grounds that there is no permanent 
point of contact for these staff in the trust; and furthermore that a named person 
in the trust is available for any of their staff to contact should they object to this 
procedure. The named person will then ensure that any objecting staff member’s 
home address is not included on the sampling data base, and internal 
distribution would then be used for such staff. A template for this communication 
is included on the Survey Documents page of the Advice Centre web site 
(www.nhsstaffsurveys.com). 

 
2. The letter that accompanies the questionnaire will contain a clause to explain that 

staff who are unable to be contacted easily at their work base have been sent 
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the questionnaires at their home addresses. A version of this letter can be found 
in Appendix 1. 

 
3. Any trust which is using an external survey contractor for sampling and/or 

questionnaire distribution, and that wishes to distribute questionnaires to home 
addresses should set up an honorary contract between the trust and one or 
two people who are already employed by the external contractor.  Under the 
terms of this contract, one or two named employees of the contractor become 
unpaid employees of the trust (while continuing to be employees of the external 
contractor) during the period in which the survey is carried out. It is then 
permissible for the contracted employee to be given staff contact details for the 
sole purpose of sending out questionnaires and reminders to staff. The external 
contractor must be registered under the Data Protection Act and appropriate 
steps must be taken to protect employee confidentiality (in the case of the 
Approved Contractors, these procedures are already in place). A sample 
honorary contract, with recommended text, can be downloaded from the Survey 
Documents page on the Advice Centre web site (www.nhsstaffsurveys.com). 

 
Please note that questionnaires should not be sent to home addresses of staff who 
have a work address to which they frequently report.  
 
 
2.6. Selecting the Staff Sample 
 
It is important that random sampling is used to select the Basic Sample.  Random 
sampling provides a statistically valid way to gather data from a manageable portion 
of the population. It allows us to take results obtained in the sample and use them as 
our best estimate of what is true for the relevant population. 
 
Once the staff list has been compiled in Excel, it will need to be passed to the survey 
contractor (if appropriate), or the person in your trust responsible for sampling, who 
will then take responsibility for drawing the staff sample.  
 
All trusts must select a random sample of employees, in accordance with the 
following detailed instructions.  This sample is referred to as the Basic Sample 
throughout these instructions.  The size of this Basic Sample will depend on the size 
of the trust, as explained below.   
 
Some trusts may want to conduct the staff survey with a larger sample than is 
required, or conduct a Census within the trust.  This is perfectly acceptable.  
However, please note that in such cases, it is still necessary to randomly select (and 
later be able to identify) the Basic Sample, according to the instructions below.  It is 
only the data provided by this Basic Sample which will be fed back to the Advice 
Centre, and will be used by the Advice Centre, the Healthcare Commission and the 
Department of Health. 
 
 
2.6.1. Determining the size of the Basic Sample 
The size of the Basic Sample is determined by the number of employees in the trust 
eligible to receive a questionnaire (i.e. the number of people on the staff list identified 
in section 2.5.1). This varies in order to guarantee a similar degree of accuracy in 
the results for all trusts. The Basic Sample sizes are: 
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Staff eligible to receive questionnaire Basic Sample size 

Up to 600 Census 
601-1000 600 

1001-1500 700 
1501-2000 750 
2001-3000 800 
Over 3000 850 

 
 
2.6.2 Relative merits of surveying the Basic Sample alone, a larger sample, or a 
census 
The advantages of conducting the survey among the Basic Sample alone are that it 
keeps costs to a minimum, and also limits the burden upon staff time.  The minimum 
sample sizes have been designed to ensure that the survey findings will give a 
statistically representative picture of the views of all staff in the trust. 
 
If trusts are considering surveying a larger staff sample or conducting a census, the 
advantages would include the possibility of more detailed sub-group analysis (e.g. 
more accurate results by directorate or occupational group), and would give more 
staff the opportunity to give their opinions.  However, the disadvantages are 
increased costs and increased burden on staff time. 
 
n.b. If a trust surveys more than the Basic Sample, it is very important that the 
Basic Sample is still selected in the way described below, and that the full specified 
survey procedures are implemented.  It should be remembered that only data from 
the Basic Sample will be transferred to the Advice Centre, and it is only this data 
which will be used by the Healthcare Commission to develop national measures. 
 
 
2.6.3. Selecting a random sample of staff 
The following steps give detailed instructions of how to draw a random sample using 
Excel. For further details about performing general tasks in Excel (such as deleting 
rows or columns) please see Appendix 5.  
 
a) Row 1 to be used for column headings 
The first row should be for column headings, such as “Name”, “Address”, “Site” etc.  
 
 
b) One employee per row  
Each subsequent row (beginning with row 2) should contain the details of one 
employee. Any blank rows, or rows containing other information (e.g. sub-headings) 
should be deleted. (See figure 1 for example.) 
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Figure 1: An example of a data file ready for sampling 

 
c) Remove any irrelevant data 
Delete any columns containing data irrelevant to the sampling, which will not be of 
any use later in the process (e.g. pay scale).   However, please keep any information 
about job title or staff group, as this will be very useful in analysing the survey 
findings, and will also enable organisations to detect any problems with the response 
rates of particular staff groups during the survey period. Also, information on 
directorate / department / division / location (as discussed in section 2.4) should be 
retained throughout.   
 
d) Insert a random number generator column 
Go to the first blank column. Give it the heading “Random” by inserting this in the first 
row. This column will be the random number generator, necessary to do the 
sampling. 
 
e) Generate first random number  
In the second cell of the “Random” column (i.e. the row containing the details of the 
first employee) enter the text “= rand( )” (without the quotation marks). Press Enter, 
and this should generate a random number between 0 and 1 (see figure 2). 
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Figure 2: Generating random numbers 

 
f) Repeat this random number generation for all cells in that column 
The simplest way to do this is to click on the first random number cell, then click on 
the small black square at the bottom-right corner of the cell. Then drag this down to 
the last row containing employee details. When the mouse is released, a random 
number between 0 and 1 is generated for each cell. 
 
g) Sort the data from lowest to highest random number  
Return to the top of the list. Highlight all columns by clicking and dragging across the 
column headers (either letters – A, B, C etc. – or numbers – 1, 2, 3 etc.). Then click 
on “Data” > “Sort”. Ensure “Header row” is selected. Then use the first drop down 
menu under “Sort by” to choose the row entitled “Random” (see figure 3). Click OK. 
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Figure 3: Sorting the data into a random order 

 
h) Select the staff to participate in the survey 
The data should now have sorted itself into a random order.  The next stage is to 
select your staff sample.  If there are to be x employees in the survey, select the first 
x + 1  rows (including the column heading row), by dragging over rows 1 to x + 1.  
Please note here:  
• if you are only planning to survey the Basic Sample, x will be the minimum 

sample size, as stipulated in section 2.6.1. 
• if you are planning to conduct a survey with a larger sample of staff, then the x 

referred to above should be this larger number  
• if a census is desired, you should select all rows  
Copy and paste this information (as appropriate) into a new worksheet. Delete the 
“Random” column from this new worksheet. 
 
i) Each selected employee to be allocated a unique identification number 
In the new worksheet containing only the selected employees, you now need to add 
ID numbers to the data.  Choose the first blank column in the new worksheet. Give it 
the title “ID Number”. In the first cell of this column (beneath the column heading 
cell), enter the value “1”. Make a note of the location of this cell: for instance, if it is 
column G, row, 2, the location is G2. If it is column 6, row 2, the location is R2C6.   
 
j) Allocate consecutive ID numbers to each selected employee 
In the cell below this, enter the text “= G2 + 1” (without the quotation marks), 
substituting for G2 if appropriate (see figure 4). This should generate the value “2” 
when you press enter. Click back on this cell, and click on the small black square at 
the bottom-right corner of the cell. When released, a sequence of ID numbers from 1 
to x should be generated. 
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Figure 4: Assigning ID numbers 

 
k) Fix the ID number values, by replicating them in the next column 
This stage is very important to ensure that each selected employee is permanently 
linked to a unique ID number.  
 
Highlight (select) all the ID numbers, along with the column heading. Click on “Edit” > 
“Copy”. Then click on the first cell to the right of this column (in the first row), and 
click “Edit” > “Paste Special”. Click on “Values” and “OK”. This will replicate the ID 
numbers.  Delete the original column of ID numbers; these are liable to change if the 
file is re-sorted. 
 
l) Specify the Basic Sample 
The Basic Sample should consist of employees beginning with ID number 1. For 
instance, if the Basic Sample size is 750, the Basic Sample should comprise ID 
numbers 1 to 750. As it will be necessary to feed back an anonymised version of the 
Basic Sample file to the Advice Centre, it is necessary (either at this stage or later) to 
separate these individuals into a new worksheet. 
 
m) Quality checks on sampling procedure 
Before questionnaires are distributed, it is necessary to double-check that the Basic 
Sample has been selected and identified correctly.  Please conduct the following 
checks on the sample: 

• each member of the Basic Sample has an allocated ID number 
• no ID numbers are duplicated 
• the Basic Sample does not include any bank staff, staff working for external 

contractors, non-payroll staff or non-executive directors 
• the sample appears to be in a random order (i.e. it is not structured so that all 

occupational groups are together, or it is in alphabetical order) 
• the proportion of staff in different staff groups or departments (where this 

information is available) appears appropriate for the trust – for example, if 50% 
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of a trust’s employees are nurses, then approximately 50% of the sample 
should be nurses as well 

 
n) Retention of staff list and Basic Sample 
It is highly important, at this stage, to make sure the file has been saved.  The Advice 
Centre will carry out some random checks on sampling procedures during October 
and November. Therefore, it is necessary to keep Excel files containing the original 
staff list, and the Basic Sample, in case they are requested by the Advice Centre, 
until the end of 2005. The list containing the Basic Sample, including directorate / 
department information, should be retained for logging of responses by the contractor 
(if the sampling has been conducted by the trust, this should be passed to the 
contractor at this stage). 
 
o) Transfer of sampling information to the Advice Centre 
The total number of staff eligible to receive the survey, and the size of the Basic 
Sample selected, should be e-mailed to the Advice Centre no later than October 14th.   
Merging PCTs should also communicate to the Advice Centre at this point whether 
they are conducting the survey jointly or separately (see section 1.7).  If the 
sampling was conducted by the trust, the name and contact details of the person 
responsible for the sampling in the trust should be included, in case the Advice 
Centre have any sampling queries later on. If the sampling was conducted by the 
survey contractor, contractors should inform the Advice Centre of this. 
 
 
2.7. Pre-survey communication with staff 
 
It is important that trusts communicate with staff during September to inform them of 
the launch of the third national staff survey. Research evidence shows that good 
communication can improve survey response rates, and help to counter the negative 
feelings experienced when staff feel over-surveyed.  
 
The communications exercise should explain to all staff in your organisation:- 

• the purpose of the survey 
• the ways in which survey findings can be used to improve staff's working lives 
• in particular, the ways in which last year’s survey findings were used within the 

trust 
• how and when staff will be receiving a questionnaire 
• how and when staff will get feedback on this year’s results 

 
It also provides an opportunity to alert staff to some of the issues in the survey. In 
particular, the survey includes questions on “Appraisals or individual performance  
development reviews” and “Personal development plans”. It is possible that some 
trusts may use different terminology for these HR practices, and staff would not 
recognise the terms. If trusts suspect that this is the case, the pre-survey 
communication should alert staff to the equivalence between the terminology used in 
their trust and the terminology used in the survey. 
 
As mentioned above, it will be important to mention results from the trust’s previous 
staff surveys, and any action the trust has taken on the basis of the results. Staff are 
more motivated to take part in surveys if they can see a tangible outcome from the 
findings, or if their views are acknowledged through trust communication. Examples 
of how trusts have used the previous results to inform policies include: introducing a 
“holiday club” to help improve work-life balance, introducing monitoring of appraisals 
to ensure all staff are appraised, improving staffing levels in areas that are “high-risk” 



 26

in terms of violence from patients (such as A & E), introduction of a team-based 
working policy across the organisation, and adapting work-life balance policies so 
that they are all-inclusive. 
 
The communication exercise also provides an opportunity to thank staff for taking 
part in the survey (and for taking part in last year’s survey if that has not already been 
done).  
 
The trusts that gained the best response rates in 2004 tended not to rely on a single 
method of communication with their staff, but to use multiple communication 
methods. Examples of these include posters, flyers, specialist “National Staff Survey 
Bulletins”, newsletters and e-bulletins, articles in trust magazines, and staff briefings. 
The trusts with the lowest response rates tended to rely on one strategy only. 
 
Some trusts – including the trust with the highest response rate in 2004 – included an 
action plan developed from the 2003 survey with the 2004 questionnaire, to show 
how results from previous surveys had been used. 
 
Examples of ready-made materials that can be used to publicise the forthcoming staff 
survey within trusts and PCTs are available to download from the Advice Centre web 
site.  These include briefing notes for managers, text that can be used in internal 
bulletins and team briefings, flyers that could be distributed with pay slips, and 
posters advertising the survey.  These examples of materials may be amended to 
suit local trust needs. 
 
Please note that it is a requirement under the Data Protection Act 1998 that trusts 
inform staff that they are administering a survey.   
 
For more details on the types of communication strategy used in trusts with high 
response rates, a separate document, “Methods for improving response rates”, is 
available on the Survey Documents page of the Advice Centre web site, 
www.nhsstaffsurveys.com. 
 
2.7.1. The Post Room 
Keeping the Post Room informed about the forthcoming survey is particularly 
important, as the staff there will play a crucial part in the internal distribution of 
questionnaires and reminders.  During the 2003 and 2004 surveys, there were delays 
in some trusts due to questionnaires getting stuck in post rooms.  This was often due 
to post room staff being unaware of of the importance of the survey timetable, which 
sometimes resulted in reminder letters being received by staff at the same time as 
questionnaires. Please see section 2.10 for further information about the survey 
distribution procedures. 
 
Research after the 2004 survey showed that post rooms were often unaware of the 
survey, or could not remember it specifically. Trusts where the post room staff had 
been fully briefed by the survey lead in the trust, and were in ongoing contact with 
that lead, tended to achieve higher response rates. 
 
The document “Methods for improving response rates” (available on the Advice 
Centre web site) includes a section on advice for communicating with post rooms.  
 



 27

 
2.8. Boosting response rates 
 
The survey procedures detailed in these Guidance Notes have been designed as far 
as possible to maximise response rates: clear questionnaire layout, ensuring staff 
work addresses are up to date for internal questionnaire distribution; targeted 
reminders; mailing out 2nd copies of the questionnaire to non-respondents; timely 
publicity of the forthcoming survey; good internal staff communication; telephone 
helplines for staff; and use of approved contractors experienced in achieving high 
postal survey response rates. 
 
There are a number of other ways in which trusts and survey contractors can help to 
maximise the survey response rates.  Some of these have been discussed in 
section 2.7, and all are discussed in detail in the document ‘Methods for improving 
response rates’, which can be found on the Advice Centre website on the Survey 
Documents page.  This document is based on the ‘best practice’ of trusts that 
achieved the highest response rates in the NHS National Staff Survey 2004. 

In summary, recommended measures include: 

1. Giving the staff survey a high profile within the trust, both before, during and 
after the survey (through the use of posters, flyers, emails, staff briefings and 
so on) – see section 2.7 

2. Explaining clearly to staff the purpose of the survey, how this year’s survey 
results will be used, what changes were made as a result of the previous staff 
surveys in 2003 and 2004, and sending out a clear message that trust 
management supports the survey – see section 2.7 

3. Ensuring a smooth internal distribution process for questionnaires and 
reminders (e.g. through close contact with the post room both before and 
during the survey period – see section 2.7.1) 

4. Identifying "survey champions" within the trust, who can help with monitoring 
early response rates, and looking at ways during the survey period of 
encouraging response among low-responding staff groups and departments 

5. Seeking to get local press coverage for the staff survey, to increase interest 
and awareness (the Healthcare Commission will be organising a press 
release about the National Survey in early October, so there should be some 
coverage in the national press) 

6. Allowing staff to complete the questionnaire during working time. 
 
The trusts with the best response rates in 2004 tended to use multiple methods to 
boost their response rates, including articles in staff newsletters, e-mails and e-
bulletins, core briefing, and tracking of response rate by department / division (to see 
where boosting was particularly needed). In contrast, the trusts with the lowest 
response rates tended to rely on just one or two methods of boosting response rates.  
Details of particular strategies employed by trusts with high 2004 response rates can 
be found in the ‘Methods for Improving Response Rates’ document. 
 
A clear demonstration to staff that senior management support the survey can be 
very important. Several of the trusts with the best response rates in 2004 included 
messages from senior management in direct connection with the survey (either 
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included in the survey packs themselves, or communicated via posters, emails or 
memos).  
 
Another factor that can help response rates is feeding back results, and developing 
action plans, from previous surveys. All of the five trusts with the best response 
rates in 2004 had developed an action plan after the 2003 survey, and 
communicated this to staff before the 2004 survey had begun. It is not enough 
simply to have developed an action plan however.  The important thing is to make 
sure that staff are aware of this plan – in 2004, although some of the trusts with the 
lowest response rates had developed action plans, it was clear that the staff in these 
trusts were unaware of this. 
 
The overall target is to achieve a 60% response rate to the National Staff Survey, 
and it is hoped that most trusts will achieve this in 2005.  Last year an overall national 
response rate of 60% was achieved, and two thirds of trusts in England achieved 
rates of 60% or higher. 
 
While there will be no penalties for trusts not achieving a 60% response rate, it is 
very important that efforts are made to achieve as high a response rate as possible.  
Without this, the survey results cannot be said to be representative of the trust as a 
whole, and it will be these results that will be used by both the Healthcare 
Commission and the Department of Health to feed into national performance 
measures in 2006. 
 
The results of your survey may be affected by a number of external events at either 
the national or local level.  For example, your trust may have recently undergone a 
merger or some other large organisational change.  It is important to record any such 
events so that your results can be interpreted in the light of such influences, and 
when year-on-year comparisons are made, external circumstances may be taken into 
account. 
 
 
2.9. Printing of questionnaires, covering letters and reminder letters  
 
2.9.1. Questionnaires 
The questionnaire compilation tool described in section 2.3 should be used to create 
a PDF document containing the Core and any Bank questions for a particular trust.  
Any Local questions should be designed on separate pages, and added to the end of 
the pages of the PDF document before printing to form a single document. 
 
The questionnaire has been designed in black, white and green, and should 
therefore be printed in colour, rather than black and white.  Experience has shown 
that the overall look of a questionnaire, including the use of colour, helps to raise 
survey response rates. 
 
The green colour used in the questionnaire is Pantone 5753C, or R:102 G:102 B:0. 
The light green used for the bands at the top of each question is a 50% tint of the 
same colour. 
 
Questionnaires should be printed as A4 booklets (i.e. a 12-side questionnaire would 
be 3 folded A3 sheets, stapled in the centre). 
 
All selected staff within a Trust should receive an identical questionnaire, in terms of 
content and format. The only difference between questionnaires distributed to 
different individuals should be in the ID number assigned during the sampling 



 29

procedure (see section 2.6.3).  There is an “Office Use Only” box on the front page 
of the questionnaire for this number to be printed or labelled.   
 
2.9.2. Covering and reminder letters 
There are three different types of letter / card, designed for use in the survey: 
 

• a covering letter, which should accompany the questionnaires and a reply-paid 
envelope (which should be printed with the return address) in the first mailing 

• a first reminder letter / card, to be sent to non-respondents three weeks later 
• a second reminder letter, which should accompany a second copy of the 

questionnaire and another reply-paid envelope sent to non-respondents a 
further three weeks later 

 
The text for these three letters has been prepared by the Advice Centre, and is 
downloadable from the Advice Centre web site.  The text is also given in Appendices 
1 to 3.   
 
The Advice Centre has obtained ethical approval for this text.  If you make any 
substantial alterations to the text, you will need to seek the approval of your local 
Trust Management Board.   However, the text allows the insertion of a return address 
and telephone number for which no additional approval is necessary.  It also allows 
the inclusion or exclusion of a sentence about use of home addresses for 
questionnaire distribution, where appropriate.  The text also includes a sentence 
giving a number for visually impaired staff to complete their questionnaire verbally 
over the telephone. All Approved Contractors have agreed to this; if non-approved 
contractors are able to provide this service then they should insert their own helpline 
number here, or otherwise insert the Advice Centre number. 
 
In addition, this year it is possible to add a short paragraph to explain how the trust or 
SHA has used results from previous surveys. This has been shown to help boost 
response rates. 
 
All letters should be printed on paper headed with the Healthcare Commission logo. 
On the basis of feedback after the 2004 survey, it is recommended this year that 
trust logos are also added to letters – this both assures staff that the trust is 
supporting the survey, and provides clarity for any staff working in multiple trusts 
about which trust they should be answering.  For merging PCTs that are conducting 
the survey jointly, the new joint logo (if available), or both PCT logos, should be 
included.  The Healthcare Commission logo and signature are being sent to trusts 
and Approved Contractors with the electronic copy of these guidance notes. 
 
When calculating the number of questionnaires to be printed, you will need to allow 
for sending out second copies of the questionnaire with the 2nd reminder letters. 
Printing costs can be unnecessarily high if a second print-run is required, so it is 
worth ensuring that the first print-run is sufficiently large to allow for contingencies.  
As a rule of thumb, it is advisable to multiply the number of staff in the sample by 1.7 
to obtain the number of questionnaires likely to be required.  So, if the number of 
questionnaires you intend to send out is 850, then you might want to print 850 x 1.7, 
or approximately 1,500 copies. 
 
It should also be noted that for each questionnaire that is printed, a first class reply-
paid envelope should be printed also. These envelopes should be printed with the 
address to which questionnaires are to be returned (i.e. that of the survey contractor). 
 



 30

 
2.9.3. Recycled paper requirements 
It is a requirement that all paper used in the publication of the NHS staff surveys, 
including questionnaires and corresponding letters, must conform to government 
requirements for the use of 100% recycled paper with a minimum post-consumer 
waste content of 80%.  It is further recommended that the paper used is uncoated 
and of standard A4 size. 
 
 
2.10. Distribution and receipt of questionnaires, and prompting non-
respondents  
 
Survey documents should be distributed to employees with permanent work 
addresses using the internal post (or other internal distribution mechanisms).  Where 
staff members do not have permanent work addresses, documents may be 
distributed to home addresses, subject to the procedures described in section 2.4.2 
being in place.   
 
Survey contractors may be used to prepare the survey packs, each labelled with a 
unique ID number, ready for internal distribution by the trust.  It is recognised that 
many trusts are based on multiple locations, each with its own post room, and in 
these cases it is preferable that survey packs be arranged into separate batches for 
the separate locations. It is the responsibility of trusts to ensure that contractors have 
sufficient information (provided with the staff list) to enable them to do this (see 
section 2.5). 
 
The three survey distribution stages are summarised below: 
 
• w/c October 3rd 1 - staff survey packs containing a questionnaire, covering letter 

and reply-paid envelope, to be distributed to all selected staff (each questionnaire 
marked with a unique identification number, in order to monitor response and 
target reminders) 

 
• w/c October 24th2 -  reminder letters, to be distributed to selected staff who have 

not yet returned a questionnaire 
 
• w/c November 14th3 - a second reminder letter, accompanied by a second copy of 

the questionnaire and pre-paid return envelope, to be distributed to selected staff 
who have still not yet returned a questionnaire 

 
Printing instructions for the various documents can be found in section 2.9. 
 
As mentioned earlier, the Post Room(s) will play a crucial part in the internal 
distribution of questionnaires and reminders.  It is important therefore to inform the 
Post Room(s) that their work load will increase over the survey period, and that they 
will be the heart of the questionnaire distribution centre.  Our previous experience of 
distributing surveys has shown that it is useful to have the name of a key contact 
person in (each of) the Post Room(s), and to thank the Post Room staff for the extra 
work involved.   
 

                                                 
1 or up to three weeks earlier 
2 or three weeks after initial mailing 
3 or six weeks after initial mailing 
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In particular, the Post Room(s) should be warned in advance of the three distribution 
stages outlined above. 
 
However, the distribution process should not be left to the Post Room staff alone. 
During the 2004 survey, the trusts with the best response rates had survey leads 
within the trusts who took ownership of the distribution process themselves, and kept 
in close contact with the Post Room staff, to ensure that distribution went smoothly 
and according to timetable. In some high response rate trusts, the survey leads also 
nominated individuals at each key site or department to take responsibility for 
'receiving' the packs of questionnaires, and to re-sort questionnaire packs, if 
necessary, to take account of staff members who had moved to a different 
department. 
 
Please note: We would advise both trusts and survey contractors to monitor this 
distribution closely during the survey period.  In past surveys, mailing out of the 
various survey packages has been delayed because Post Room staff were unsure of 
the distribution timetable.   
 
2.10.1. Taking receipt of completed questionnaires 
Each questionnaire should be marked with a return address to which staff should 
send their completed questionnaires.  As mentioned earlier, this should be the 
address of an external survey contractor, and preferably an Approved Contractor. 
The contractor should log the return of each questionnaire according to its unique ID 
number and the date when it was received.   
 
At the end of the sampling process (section 2.6), an Excel file containing the names 
and ID numbers of the sample should have been saved, and passed to the contractor 
if the sampling was done by the trust. When a completed questionnaire for a 
particular ID number is returned, this should be noted on the Excel file by typing “C1”, 
“C2” or “C3” in the cell immediately to the right of the ID number (N.B. this is a new 
procedure this year).   
 
• “C1” should be used when the questionnaire was returned before the respondent 

received a reminder letter 
• “C2” should be used when the questionnaire was returned after the respondent 

received the first reminder letter, but before the second reminder letter 
 
• “C3” should be used when the questionnaire was returned after the respondent 

received the second reminder letter 
 
(It is acknowledged that sometimes it may be unclear whether reminder letters had 
been received before the questionnaire was returned. As a rule of thumb, assume 
that questionnaires returned up to and including a day after reminder letters have 
been sent out, were returned before the recipient received the reminder.) 
 
Please use the following codes to record the different types of staff response, against 
the appropriate ID numbers: 
 
 

Response 
code 

Type of response 
 

  
C1 

 
Completed questionnaire returned before the respondent received 
a reminder letter 
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C2 

 
Completed questionnaire returned after the respondent received 
the first reminder letter, but before the second reminder letter 
 

C3 
 

Completed questionnaire returned after the respondent received 
the second reminder letter 
 

B 
 

Blank questionnaire returned 

REF 
 

Staff member explicitly opted out / refused to take part 

INEL 
 

Staff member ineligible for survey (e.g. no longer working at the 
trust, or not directly employed by the trust) 
 

N Questionnaire not returned (reason not known) 
 

 
 
For staff members who contact the trust or contractor to explicitly opt out of the study, 
or turn out to be ineligible for the survey, no more reminder letters should be sent. 
 
If a questionnaire is received in such a state that the ID number has been removed or 
made illegible, this questionnaire should not be included in data transferred to the 
Advice Centre.  However, the occurrence should be noted, and the number of 
questionnaires returned without legible ID numbers should be reported to the Advice 
Centre with the response rates. 
 
 
2.10.2. Monitoring response rates, and sending out reminders 
This log of questionnaire returns against ID numbers will enable contractors to 
monitor response rates during the survey period.  
 
For example, it may become apparent, using this log, that a particular department 
has a very low response rate compared with others.   If this is the case, it will be 
worth exploring the reason for that low rate.  It might be that distribution in that 
department has not taken place as planned, or it may be necessary to further 
publicise and promote the survey within that department. Contractors should ensure 
that they have systems set up to enable such monitoring. 
 
The log of questionnaire returns against ID numbers should also be used to target 
reminders at non-responding staff. 
  
First reminder 
Three weeks after the questionnaires are distributed, a reminder letter or card needs 
to be sent to all staff who have not yet returned a questionnaire (i.e. those ID 
numbers for which no questionnaire has been logged).  Please note that the first 
reminder should be in a sealed envelope. 
 
Please do not send reminders to staff whose questionnaires have already been 
logged. 
 
Second reminder 
Three weeks after the first reminder letter (six weeks after the initial questionnaire 
mailing), a further survey pack should be distributed to staff who have still not 
responded.   
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This survey pack should contain a reminder letter, a 2nd copy of the questionnaire 
(marked with each staff member's unique ID number) and a 2nd reply-paid envelope.  
 
Please do not send survey packs to staff whose questionnaires have already been 
logged. 
 
 
2.10.3. Informing the Advice Centre of ongoing response rates (New for 2005) 
Please keep the Advice Centre informed of progress with response rates during the 
survey period.  If the Centre is made aware of problems with response rates at an 
early stage, Centre staff may be able to offer advice and help in raising the response. 
 
It is the responsibility of survey contractors to inform the Advice Centre of response 
rates on a weekly basis (every Thursday), from the week commencing October 3rd 
onwards. Please also inform the Advice Centre of the dates that questionnaires and 
reminder letters were sent out, so that the effect of the reminders can be monitored. 
 
 
2.10.4. Informing the Advice Centre of advice line queries (New for 2005) 
Contractors should also keep the Advice Centre informed of queries received by their  
advice lines on a weekly basis. In addition to the update on response rates each 
Thursday (during the survey period), contractors should inform the Advice Centre of: 
• the types of queries received by the advice line during the previous week (e.g. 

concerns about confidentiality, unsure how to answer questions) , and 
• the number of each type of query received. 
 
 
2.11. Data entry and data transfer to the Advice Centre 
– instructions for the survey contractor 
 
The deadline for transfer of data to the Advice Centre is Friday 16th December.  
 
This section gives information for contractors about how sample data, and data from 
returned questionnaires, should be entered and transferred to the Advice Centre. It is 
the responsibility of the contractor to enter data from returned questionnaires into two 
given Microsoft Excel files (one for Core questions and one for Bank questions), and 
then to return this data to the Advice Centre at Aston University by 16th December. 
 
For the first time this year, data from optional Bank questions (excluding the 
directorate / department question, if used) should be returned to the Advice Centre. 
National benchmarks for these questions will then be provided by the Advice Centre 
after the survey, to allow trusts to analyse their results in a more meaningful way. A 
separate Excel template is being made available to contractors to enter this data. 
 
If it is clear that there will be a delay in transferring the data to the Advice Centre, 
please alert the Advice Centre at the earliest opportunity.  However, in order to meet 
the analysis and reporting requirements for the Healthcare Commission and trusts, 
we are reliant upon the vast majority of trusts meeting the target deadlines. 
 
The data to be returned by this date includes 3 files: 
• The anonymised staff sample file (Excel), containing records of which staff have 

and have not returned questionnaires 



 34

• Two questionnaire data files (Excel), containing data from returned questionnaires  
(one file contains Core questions, the other Bank questions) 

 
In addition, the final response rate should be reported to the Advice Centre along 
with this data.  The response rate is defined as the proportion of questionnaires 
distributed which are returned completed with clear ID number.  However, the 
number and proportion of: 
• blank questionnaires returned 
• questionnaires returned without legible ID number (if trust identification is not 

possible, a total number for all trusts should be reported) 
• staff members who explicitly opted out / refused to take part 
• staff members who were reported as ineligible for survey 
should also be reported. 
 
Note that the final trust response rate may be recalculated by the Advice Centre, to 
ensure that all response rates are calculated in precisely the same way. 
 
2.11.1. Staff Sample File 
This is an Excel file compiled during the sampling and questionnaire receipt stages, 
as described in sections 2.5 and 2.10.  The file should only include members of the 
Basic Sample, and should also include: 
• ID number 
• whether or not, and when, they returned a questionnaire (or were ineligible, or 

refused to take part) – recorded as described in section 2.10 
• directorate / department etc. of staff (whichever breakdown or breakdowns are 

being used for the standard Advice Centre feedback report) 
• job title if available. This information will be used for refining occupational group 

categories in future surveys 
 
This file should be anonymised, i.e. staff names should be removed.  
 
 
2.11.2. Questionnaire Data File 
Data from returned questionnaires must be entered into a fixed, consistent electronic 
format. It is important that the data is entered exactly as indicated in these 
instructions; if there are discrepancies then it may lead to mistakes in the data 
analysis. 
 
The data returned to the Advice Centre should only include members of the Basic 
Sample.  It should also include only data from the Core and Bank questions, not 
Local questions. 
 
Method of data entry 
Two templates for data entry are downloadable at www.nhsstaffsurveys.com. These 
templates are Microsoft Excel worksheets, containing column headings for each 
question on the questionnaire – one for the Core questionnaire, and one for Bank 
questions. The data from each questionnaire should then be entered into a single 
row on these worksheets.  All data from each contractor should be entered on a 
single pair of worksheets, except where there are over 10,000 responses, in which 
case data should be entered on as few worksheets as possible. 
 
Data may be entered directly into these template worksheets, or may be copied from 
another worksheet.  One template includes Core questions first, and the other Bank 
questions, so contractors may find it easier to enter the data into another worksheet 
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in questionnaire order, and then transfer the Core and Bank questions into their 
respective places in the templates.  
 
Note that the Bank questions in the template appear in the same order in which they 
appear in the Compilation Tool. However, since trusts are extremely unlikely to use 
ALL Bank questions, there is likely to be some blank space between questions. 
Question numbers on this template refer to the version of the Optional 
questions that is downloadable from the Advice Centre web site.   
 
Data should mostly be entered as numbers rather than words.  The first column is for 
a Trust ID code, and should include the three-letter NHS code of the trust for which 
the respondent works. 
 
The ID number of the questionnaire should be entered in the second column. On the 
Core questionnaire template, the third column is for the first directorate / department 
information (coded numerically – i.e. with one number for each category), and the 
fourth for the second breakdown (if used). The fifth column should be used for the 
respondents’ job titles, where these were available from the original staff list (or left 
blank otherwise). 
 
Codes to be entered for the different question options are printed in small type on the 
questionnaire, adjacent to the relevant tick-boxes.  The only exceptions to this are: 
 
• three questions where respondents have the option to write in an answer – a 

separate column is provided within the Excel file for this information to be entered 
(see also later section on data cleaning) 

• the general comments box at the end, which should be entered into the final 
column as text, and in normal sentence case. These should be entered verbatim, 
except that names of individuals should be removed, and obscenities deleted (or 
asterisked out).  If any other information is given that could lead to identification of 
the respondent, then these comments should be withheld and not entered. 

 
There are some scenarios when questionnaires do not contain data in the expected 
format: 
• Any questions left unanswered should be left blank in the Excel file. 
• For most questions requiring a single tick only, if respondents have ticked more 

than one response at those questions, the data should be treated as missing 
(i.e. left blank) 

• The one exception to this is the occupational group question (question 40 in the 
trust Core questionnaire1). For this question, see the rules on data cleaning later 
in this section. 

 
 
Data checking 
It is important that the following data entry checks are carried out on the Basic 
Sample data in each trust: 
 
• has the data been entered accurately? (this can be done by double-entering the 

data from a proportion of questionnaires, or directly comparing the hard-copies of 
the questionnaires to the entered data; if data is scanned, the latter check is also 
possible) 

 

                                                 
1 Question 39 in the SHA version of the Core questionnaire 
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• has the data been entered in the right columns in the data entry worksheet? (it 
can be easy to enter the correct data, but in an incorrect column). This is 
particularly important for Bank questions 
 

• for each question, have valid values been entered? (e.g. for a question with 
answer category values 1-5, check that there are no entered values outside this 
range) 

 
• does the file for transfer to the Advice Centre contain all completed questionnaires 

from the Basic Sample? (checks should ensure that no data from a Basic Sample 
staff member have been excluded from the file; and also that all data from non-
Basic Sample staff members have been excluded) 
 

The Advice Centre will be conducting some random quality checks on data entry 
during January 2006.  This means that some randomly selected specific 
questionnaires (identified by ID number) may be requested from contractors, and 
these will be checked against the data provided.  Therefore, it will be necessary to 
retain all hard copies of questionnaires until at least the end of February 2006.  
 
Data cleaning 
The following instructions are for Approved Contractors, and for other contractors 
scanning (rather than keying) their questionnaire data. 
 
There are a number of filtered questions in the core questionnaire, and the following 
rules should be applied, when scanning or cleaning the data. 
 
Sometimes, a member of staff may have given inconsistent responses to a set of 
filtered questions (e.g. the appraisal question, which is Q9 in the Core questionnaire).  
For example, they may have said "No" to an initial filter question, but rather than 
following the instruction to skip onto a later question, they have answered the follow-
up questions. 
 
Taking the appraisal question as an example, the following rules should be applied: 
• If 9a is left blank, but there are answers given at 9b, 9a should be imputed as yes 
• If 9a is given as “no”, but there are answers given at 9b, both questions should be 

set to missing (i.e. left blank) 
 
These rules should be applied to all questions with filter instructions – shown in green 
italics on the questionnaire. 
 
For the write-in questions, if it is clear from the written response that a different 
category should have been ticked (e.g. at question 36 in the trust Core 
questionnaire1), if someone writes in “Chinese”, which is a category in its own right), 
then the response should be changed appropriately. 
 
As mentioned earlier, for most questions requiring a single tick only, if respondents 
have ticked more than one response at those questions, the data should be treated 
as missing (i.e. left blank).  However, for the occupational group question (question 
40 on the Core questionnaire2), priority coding should be applied to multiple 
responses: 

                                                 
1 Question 35 in the SHA version of the Core questionnaire 
2 Question 39 in the SHA version of the Core questionnaire 
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• Within the Registered Nurses and Midwives section, prioritise Midwife, Health 
Visitor or District/Community over Adult/General, Mental Health, Learning 
Disabilities or Children  

• For other types of multiple responses in the Nurses (Registered) section, re-code 
as “Other registered nurses” 

• If two occupational groups are ticked, including General Management, prioritise 
the other occupational group 

 
2.11.3. When the data has been entered 
If a contractor is returning data from only one trust, please save the staff list Excel file 
as the three-letter NHS code of the organisation from which the data came appended 
by “sample”, so that it can easily be identified by the Advice Centre. For example, for 
a trust with NHS code AAA this would be “AAA sample.xls”.  Contractors that are 
returning data from multiple trusts in the same worksheet should save the file with the 
name of the contractor. If multiple sheets are used, these should be given separate 
numbers, e.g. “Organisation1.xls”, “Organisation2.xls” etc. 
  
All files should also be password protected, with the password being assigned by the 
trust or contractor and sent to the Advice Centre in a separate e-mail. 
 
 
2.11.4. Transferring the data 
Please send the data on a floppy disk, or CD, to: 
 
NHS National Staff Survey Advice Centre, 
AMIRS, 
Main Building 252, 
Aston Business School, 
Aston University, 
Aston Triangle, 
Birmingham B4 7ET 
 
Please also e-mail the data to the Advice Centre at m.r.carter@aston.ac.uk, together 
with the following information: 
• the overall response rate for the Basic Sample at each trust 
• total number of valid responses received at each trust (i.e. those from the Basic 

Sample with data entered) 
• the number of blank questionnaires returned for each trust 
• the number of ineligible staff contacted for each trust 
• the number of questionnaires returned with ID number removed (overall – 

obviously not possible for each trust) 
• the overall number of questionnaires checked and errors found, contained within 

the text of the e-mail 
 
Contractors who are conducting surveys for many trusts may return the data in bulk, 
as long as: 
• the total size of any e-mail is no more than 5MB 
• both documents for any trust, and the response rate & data checking information 

for that trust, are contained within a single e-mail (although passwords should be 
given in a separate e-mail). 
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2.12. Reports of the survey findings 
 
The Advice Centre will provide a report on the survey results for each trust.  These 
will include frequencies of staff responses to all Core questions, summary scores for 
all scales, some breakdown of scores within trusts, and guidelines for interpretation 
of scores.  All scores will be benchmarked against data for all trusts nationally and for 
similar types of trust. The reports will be similar to last years’, except that some key 
scores will be altered to reflect the recent changes in the questionnaire. Examples of 
trust feedback reports from the two previous survey years can be found online at 
http://www.healthcarecommission.org.uk/staffsurveys/.  
 
These benchmarked reports will be sent to trusts, and published on the Healthcare 
Commission web site, during February / March 2006.  A short report on the national 
data will be published in March 2006; further analysis on the national survey data will 
be published in the summer of 2006. 
 
In addition, the Advice Centre will provide benchmarks for the Bank questions in 
March 2006, so that trusts which used these can compare how they did with other 
trusts nationally. 
 
Some trusts may want to commission additional analysis of their own data, or early 
analysis of the trust level data, before the Advice Centre reports are published1.  This 
must be negotiated separately with their survey contractors or data analysts. 
 
As soon as the trust report of the 2005 staff survey is available, staff should be 
informed about they can access the results.  This will show staff that their 
contribution is valued, and will help response rates in future surveys (see section 2.8 
for further information).  
 
To assist trusts in interpreting and using their results, the Healthcare Commission will 
be running a series of regional workshops in March 2006.  Guidance will be given on 
how to interpret the survey results, how to use the results to inform the development 
of local action plans, and how to communicate the survey findings and action plans to 
trust staff.  
 
 
2.13. Ethical considerations 
Aston University were awarded ethical approval for the development of the National 
Staff Survey by the MREC North West Board. 
 
Trusts are required through the 1998 Data Protection Act to inform their staff that 
they are being surveyed.  Trusts are at liberty to choose the most appropriate forms 
of communication for their trust to enact this request. 
 
Trusts are not required to submit any local questions through their local LREC board.  
However, they are required to submit local questions for approval through their Trust 
Management Board. The Core and Bank questions provided by the Advice Centre, 
however, require no further approval. 

                                                 
1 (Please note: In order to make fair comparisons between trusts in the Advice Centre reports, 
the data from individuals within each trust will be weighted so that the occupational group 
profile of that trust reflects that of a typical trust of its type.  Therefore it is possible that results 
given in the Advice Centre reports will differ slightly from those given in reports from 
contractors, even if only the Basic Sample was analysed in those cases). 
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The Advice Centre is aware of the ethical implications of handling and storing 
sensitive data.  Space has been allocated to ensure that data will be stored in locked 
accommodation.  The data will be analysed on secure IT equipment that has strict 
password entry.  The Advice Centre is ultimately responsible to Aston University for 
the handling of sensitive data.    
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Appendix 1 
 

Covering letter to be sent to employees w/c October 3rd (or earlier) 
[Sections in blue are to be altered according to each trust’s/contractor’s needs] 
 
Dear Colleague, 

NHS National Staff Survey 
 

We are writing to ask for your help with the 2005 National NHS Staff Survey, which is 
being conducted by researchers from [contractor], Aston University and the 
Healthcare Commission.  [Your name was selected at random from a list of all staff 
working for your trust.] [Please note that some staff who do not frequently report to a 
permanent work address may have been sent a questionnaire at their home 
address.] 
 
The survey asks for your views about work and the [trust] for which you work.  The 
aim of the survey is to help the NHS to provide better care for patients and improve 
the working lives of staff.  Your [trust] will be able to use the survey to inform 
improvements in working conditions and practices at a local level.  The Healthcare 
Commission will use the survey findings in their reviews of the NHS, and in their 
annual Health Check, as part of the assessment of your trust’s compliance with 
Department of Health core standards.  The survey results will also enable the 
Department of Health to assess the effectiveness of national NHS staff policies (such 
as training and flexible working policies) and to inform future developments in this 
area.   
 
Results from the two previous national surveys, in 2003 and 2004, can be accessed 
online at www.healthcarecommission.org.uk/staffsurveys/.  A similar survey is being 
conducted in all trusts in England this year, which will enable us to observe any 
changes in staff views and experiences over the past year.  This is an important way 
of ensuring that NHS staff views regularly feed into local and national policies.  
Therefore we would urge you to complete this questionnaire, even if you took part 
last year. 
 
[A SHORT PARAGRAPH MAY BE ADDED HERE TO SHOW HOW RESULTS 
FROM PREVIOUS SURVEYS HAVE BEEN USED IN THIS TRUST.] 
 
Your participation in the survey is entirely voluntary.  However, by completing the 
questionnaire, you will provide valuable information which will be used to improve 
NHS working practices and patient care.  The results of this survey will only be truly 
representative if all selected staff complete and return the questionnaire. 
 
Your answers will be treated in the strictest confidence.  No one from your trust will 
see your completed questionnaire or be able to identify an individual's responses.  
The completed questionnaires will go straight to [contractor], an independent survey 
organisation. Your personal data are held in accordance with the Data Protection Act 
1988, and the principles of the NHS Confidentiality Code of Practice.  Your work 
contact details have been passed to [contractor] only so that they can send you this 
questionnaire and process your response.  [Contractor] will process your answers in 
confidence and keep them separate from your contact details.  All name and address 
information relating to this survey will be destroyed within a maximum of three 
months of completion of the survey. 
 
The [contractor], Aston University and the Healthcare Commission will produce 
anonymous statistics from the responses for each NHS Trust taking part in the 
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survey.  The results will be presented in summary reports, in which no individual's 
answers can be identified.   
 
We very much hope you agree to take part, and would be grateful if you could return 
your completed questionnaire, to [insert return address].  Blind or visually impaired 
staff may complete the questionnaire over the telephone, by calling the [Advice 
Centre / Contractor name] helpline on [0121 359 2491] / [contractor helpline number]. 
 
If you have any questions or comments about this survey, you can find out more by 
logging onto the Staff Survey Advice Centre web site (www.nhsstaffsurveys.com), or 
by calling [the Survey Helpline on 0121 359 2491 (available 10-4 on weekdays)] [if 
contractor or trust helpline is available, insert detail here]. 
 
Many thanks for your help with this important survey. 
 
Yours sincerely, 
Lorraine Foley 
Head of Information and Analysis 
Healthcare Commission 
 
[TRUST CHIEF EXECUTIVE’S SIGNATURE MAY ALSO BE ADDED] 
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Appendix 2 
 

Reminder letter to be sent 3 weeks after original questionnaire 
 
 
Dear Colleague, 

NHS National Staff Survey 
 
About three weeks ago we sent you a questionnaire seeking your opinions about 
working in the NHS.  [Your name was randomly selected from a list of all staff 
working for your NHS trust.] 
 
If you have already completed and returned the questionnaire, please accept our 
sincere thanks, and we apologise for this reminder.  If you have not received a copy 
of the questionnaire, or have any other queries, please contact [Contractor name] on 
[Contractor number]. 
 
If you have not yet completed the questionnaire, please do so today and return it to 
[insert address here].  It is only by hearing the views of as many staff as possible, 
that we can assess the success or otherwise of NHS working practices and policies.  
 
Many thanks for your participation. 
 
 
Yours sincerely, 
 
Lorraine Foley 
Head of Information and Analysis 
Healthcare Commission 
 
[TRUST CHIEF EXECUTIVE’S SIGNATURE MAY ALSO BE ADDED] 
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Appendix 3 
 

Reminder letter to be sent three weeks after first reminder 
 

Dear Colleague, 
NHS National Staff Survey 

 
About six weeks ago, we sent you a questionnaire asking about your experiences of 
working in the NHS.  Many staff have already completed and returned this 
questionnaire, and if you have done so, please accept our sincere thanks.   
 
The results of this national survey – the third time such a national survey has taken 
place – will be extremely valuable to the Healthcare Commission, the Department of 
Health and your local trust, for improving patient care and the working lives of staff.  
This annual survey is an important way of ensuring that NHS staff views regularly 
feed into national and local NHS policies. 
 
If you have not yet returned your questionnaire, we are writing again because of the 
importance that your questionnaire has for helping to get accurate results.  Although 
we sent questionnaires to a wide range of staff in the trust, it is only by hearing from 
everyone in the sample that we can be sure that results are truly representative.  We 
have enclosed another questionnaire in case you have misplaced the original one. 
 
We would like to reassure you that information released to the trust will be in a form 
that protects individuals' anonymity, and any report of the trust survey will be written 
in summary form, in which no individual's answers can be identified.  As the 
questionnaires are sent directly to [contractor] - an independent survey organisation, 
no-one from your trust will see your completed questionnaire, or be able to identify an 
individual's responses. 
 
If you have any queries relating to the survey, please call the [contractor name / 
Advice Centre] helpline on [contractor number / 0121 359 2419].  Blind or visually 
impaired staff may complete the questionnaire over the telephone, by calling the 
same number. 
 
 
Many thanks in anticipation of your help. 
 
Yours sincerely, 
 
Lorraine Foley 
Head of Information and Analysis 
Healthcare Commission 
 
[TRUST CHIEF EXECUTIVE’S SIGNATURE MAY ALSO BE ADDED] 
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Appendix 4 
 

Summary of files/information to be transferred to the Advice Centre 
 

Document/Information How returned By when By whom Where in 
guidance notes 

Name/contact details of two people responsible for the 
survey in the trust 

E-mail As soon as possible Trust Section 2.1 

Number of staff in trust eligible to receive questionnaire; 
size of Basic Sample 

E-mail By October 14th  Trust or contractor Section 2.5 

Name and contact details of person responsible for 
sampling 

E-mail By October 14th Trust or contractor  Section 2.5 

Decision on whether survey is conducted jointly or 
separately (merging PCTs only) 

E-mail By October 14th Trust or contractor  Section 1.6 

Response rates during the survey period, dates of 
questionnaire and reminder mailings, and summary of 
queries to advice line 

E-mail Weekly after 
questionnaires are 
sent out 

Contractor Section 2.9 

Details of directorate etc. breakdown E-mail By December 9th Contractor Section 2.4 

Data documents (Staff sample file, Questionnaire data file) By post, and as 
attachment to e-mail 

By December 16th  Contractor Section 2.10 

Other information – final response rate & number of 
completed questionnaires received, number of blank 
questionnaires returned, number of questionnaires 
returned with ID number removed, number of ineligible 
staff contacted, number of questionnaires checked, 
number of errors found, password for data files 

E-mail By December 16th Contractor Section 2.10 

Questionnaires for data checking By post (recorded delivery) On request from 
Advice Centre 

Contractor Section 2.10 

Staff list and sample Attachment to e-mail On request from 
Advice Centre 

Trust or contractor Section 2.5 
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Appendix 5 
 

Detail of how to perform some procedures in Excel 
 
 
(a) Inserting a blank first row 

Click on the top, left hand cell (usually ‘A1’ or ‘R1C1’) and then “Insert” > 
“Rows”. This should insert a blank row, which can be used for headings. 

 
(b) Deleting rows  

To delete a row, highlight it by clicking on the row number at the extreme left-
hand end of the row, and click on “Edit” > “Delete”. 

 
(c) Deleting columns 

Deleting a column is done in the same way as deleting rows (see b). 
 
(d) Selecting multiple rows 

Place the mouse pointer over the row number of the first row you wish to 
select (on the far left hand side of the worksheet). Click and drag down to the 
row number of the last row you wish to select. When the mouse is released, 
these rows should then be highlighted. 

 
(e) Copying and pasting multiple rows into a new worksheet 

When rows are selected, click on “Edit” > “Copy”. Open a new worksheet by 
clicking “File” > “New”. Paste in the rows by clicking “Edit” > “Paste”. 
 

Changing the cell reference style from ‘R1C1’ to ‘A1’ 
Some operations are easier to carry out with the ‘A1’ style of cell reference, 
rather than the ‘R1C1’. To change this, click on “Tools” > “Options”, then the 
“General” tab, and uncheck “R1C1 reference style”. 
 

Password protecting files 
To make sure that a file can only be accessed by someone who knows a 
password, click on “File” > “Save As”. Then click on “Tools” > “General 
Options”. Enter a password which will protect the file before saving it. 
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Appendix 6 
 

Development of the survey 
 
2005 NHS National Staff Survey 
In Spring 2005, the Healthcare Commission, together with NHS Employers, 
conducted a consultation exercise, to seek feedback on the content of the 2005 NHS 
national staff survey.  One of the key aims was to maintain stability in the survey from 
year to year in order to ensure that there is good national and local trend data. 
However we were also aware that there were topics of interest to trusts and other 
stakeholders that were not covered by the 2004 survey.  Trusts were asked for their 
thoughts about the questions that should stay in the survey, which should be 
removed, and which should be added. The overall aim was to ensure that the NHS 
National Staff Survey continues to meet local as well as national data needs.  
 
As a result of this consultation, and feedback from withini the Healthcare 
Commission, Department of Health and other national NHS bodies, the questionnaire 
was reviewed and revised by Maritz research, who developed and tested a set of 
new questions for the 2005 survey.   
 
Following this consultation and testing procedure, four entirely new questions have 
been added to the questionnaire, and several others changed. For details of these 
changes, see Appendix 10. A document “Questionnaire Changes in 2005” which 
explains the reasons for these is available on the Advice Centre web site. 
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Appendix 7 
 

Contact Details of Approved Contractors 
 
 
Maritz 
Contact: Emma Frodin / Wendy Goodier / Carly White 
Telephone: 01628 895305 
e-mail: efrodin@maritz.co.uk; wgoodier@maritz.co.uk 
Maximum survey capacity: 50 trusts 
  
MORI 
Contact: Helen Rice / Claire Gevaux 
Telephone: 020 7347 3000 
e-mail:  helen.rice@mori.com; claire.gevaux@mori.com 
Maximum survey capacity: 200+ trusts 
 
NHS Partners’ Research and Information 
Contact: Cheryl Kershaw / Aimi Blueman 
Telephone: 01423 720212 
e-mail: cheryl.kershaw@nhspartners.org.uk; aimi.blueman@nhspartners.org.uk 
Maximum survey capacity: 300 trusts 
  
Picker Institute Europe 
Contact: Nick Richards / Sheena MacCormick 
Telephone: 01865 208100 
e-mail: nick.richards@pickereurope.ac.uk; Sheena.MacCormick@pickereurope.ac.uk 
Maximum survey capacity: 200+ trusts 
 
Quality Health 
Contact: Reg Race / Mandy Moore / Kerry Hibberd 
Telephone: 01246 856263 
e-mail: reg.race@quality-health.co.uk; mandy.moore@quality-health.co.uk; 
kerry.hibberd@quality-health.co.uk; 
Maximum survey capacity: 200+ trusts 
 
RBA Research 
Contact: Joanna Bottomley / Natalie Metcalf / Tina Dodds 
Telephone: 0113 285 6300 
e-mail: joanna.bottomley@rba-research.co.uk 
Maximum survey capacity: 200 Trusts 
  
Taylor Nelson Sofres 
Contact: Pooja Sachdev 
Telephone: 020 8967 4259 
email: pooja.sachdev@tns-global.com 
Maximum survey capacity: 50 trusts 
  
 
More detailed information about the Approved Contractors, including their quotations 
for providing the survey services can be found in the Service Level Agreement which 
is available on the Advice Centre web site (www.nhsstaffsurveys.com). 
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Appendix 8 
 

Questions for use in the Health and Safety Executive Stress Audit 
 
The Core questionnaire includes questions to fulfil the Health and Safety Executive’s 
(HSE) stress audit. Details of the questions which map onto the HSE standards can 
be found in the following table. The HSE has agreed that trusts will not need to carry 
out a separate survey to cover this.  
 

HSE Stressor Question number 
(core questionnaire) Question text 

 
Control 19f I can decide on my own how to go about 

doing my work 

Role 16a I have clear, planned goals and objectives 
for my job 

Relationships 30c, d In the past 12 months have you 
experienced harassment, bullying or 
abuse from any of the following? 

(c) manager/team leader 
(d) colleagues 

Relationships 19e Relationships at work are strained 

Demands 16d I cannot meet all the conflicting demands 
on my time at work 

Demands 16e I am asked to do work without adequate 
resources to complete it 

Demands 16f I am required to do unimportant tasks 
which prevent me from completing more 
important ones 

Demands 19c I do not have time to carry out all my work 

Change 19b I am consulted about the changes that 
affect my work area / team / department 

Support 18d I am satisfied with the support I get from 
my work colleagues 

Support  18b I am satisfied with the support I get from 
my immediate manager  
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Appendix 9 
 

Questions that can be used in trusts' assessments of Improving Working Lives 
 
Most of the questions in the NHS Staff Survey 2005 are directly relevant to Improving 
Working Lives.  The following table takes each of the seven areas of good practice, 
as listed in the IWL Standard (2000) and referred to in the IWL Practice Plus National 
Audit Instrument, and lists the precise core survey questions that are relevant to each 
area.  Some questions and scores are relevant to more than one area of good 
practice. There are a number of additional questions available in the optional Bank, 
which are also relevant to Improving Working Lives. All the optional questions can be 
downloaded from the Advice Centre web site (www.nhsstaffsurveys.com). 
 
 

IWL area NHS Staff Survey 2005 core questionnaire question numbers 
(trust version) 
 

HR Strategy & 
Management 

Q9a-d (appraisals) 
Q10a-c (personal development plans) 
Q15a-e (team working) 
Q17a-e (intention to leave the job) 
Q21a-e (management and supervision) 
 

Equality & 
Diversity 

Q12a-f (training in equal opportunities, or awareness of 
race/gender etc) 
Q18a-g (satisfaction with various elements of job) 
Q21a-e (management & supervision) 
Q23a-b (equal opportunities) 
Q6, 35, 36, 391 (demographic profile of staff) 
 

Staff 
involvement & 
communication 

Q16a, Q19a (clear job content) 
Q16b, Q18a, Q19d (feedback) 
Q16c, Q19b (staff involvement) 
Q21a-e (management & supervision) 
Q22a-f (views about the way the organisation is run) 
 

Flexible working Q3a-c (employer's attitude towards work life balance) 
Q4a-g (flexible working options) 
Q5 (flexible retirement) 
 

                                                 
1 Q 6, 34, 35, 38 in the SHA version of the Core questionnaire 
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Healthy 
Workplace 

Q1b-c (working additional hours) 
Q2 (reasons for working additional hours) 
Q13a, b, d (health & safety training) 
Q24a-b (whistle blowing) 
Q25a-c, 26 (witnessing and reporting errors & near misses) 
Q27a-g (incident reporting) 
Q28a-e (work-related injuries or sickness) 
Q29a-e (physical violence) 
Q30a-e (harassment, bullying & abuse) 
Q31 (reporting violence or harassment) 
Q32a-d (views about employer's effective action towards violence & 
harassment) 
Q33a-c (availability of hot water, soap, towels & alcohol rubs) 
Q34a-c (promotion of hand washing) 
 

Training & 
Development 

Q11a-g (Training) 
Q12a-f (Equal opportunities & awareness training) 
Q13 (Training in specific areas) 
Q14 (Barriers to training) 
Q23a (Equal access to career progression & development) 
 

Flexible 
Retirement, 
Childcare & 
Support for 
Carers 

Q5 (opportunities for flexible retirement) 
Q7a-e (care options offered by employer) 
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Appendix 10 
 

Changes to questions in the Core Questionnaire 
 
A number of changes have been made to the questionnaire since the 2004 survey. 
These changes were based on extensive consultation with trusts, strategic health 
authorities, the Healthcare Commission, the Department of Health, and other 
stakeholders.  An explanation of the reasons behind these changes is given in the 
document “Questionnaire Changes in 2005”, available on the Advice Centre web 
site, and is being circulated to all trusts, SHAs and contractors. 
 
2005 question numbers refer to the 2005 trust Core questionnaire. 
 
New questions added 
 
Question number Content of question 
13 Training in specific areas 
14 Difficulties in access to training 
33 Infection control and hygiene 
34 Infection control and hygiene 
 
 
Questions dropped (all are still available as Bank questions) 
 
Question number (2004) Content of question 
10 Training for people conducting appraisals 
13 Number of days on taught courses 
14b Number of teams worked in 
15b, 15c Access to occupational health and counselling services 
19e Increased responsibilities over previous year 
22e, 22h Job design items 
23b Supervisor support item 
24 Senior management leadership 
25a, 25f Organisational climate items 
38 Bank shift working 
 
 
Questions altered 
 
Question number (2005) Alterations made 
1a Answer options are reduced to a simple full time vs. part 

time categorisation 
1b, 1c Upper two categories: “21-25 hours” and “more than 25 

hours” combined into one category: “more than 20 hours” 
4 Focus of question changed from awareness of flexible 

working options to use of flexible working options 
Definition added to flexi-time 
Flexible retirement moved to question 5 
Working during school term-time only added 

5 Question combined with number 4 
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6 Question moved from background details 
Text amended to more clearly identify carers 
Includes dependants living elsewhere 
“Other dependant(s)” category added 

7 Now asked only of those with dependants 
11 “Secondment” deleted as an option 

“Keeping up to date with developments in your type of 
work” added as an option 

15 Part b deleted 
17 Additional category “Would like more pay” added 
22f Question now refers to “standard of care”, for clarification 
23b Expanded to ask about discrimination on the basis of six 

separate issues 
25a, 25b Response options simplified to yes/no 
27 Some questions about feedback added. Response 

changed to a 5-point scale (strongly disagree to strongly 
agree) 

40 Several occupational group categories expanded 
 
In addition, some terminology has changed consistently through the questionnaire. 
All references to “organisation” or “employer” have been replaced by “trust” or “SHA” 
as appropriate, and all references to “manager” or “supervisor” have been replaced 
by “immediate manager”. “Performance review” has become “performance 
development review”. “Training” is referred to throughout as “training, learning and 
(or) development”. “Errors and near misses” is consistently expanded to “errors, near 
misses or incidents”. 
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